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Quick start guide
Movavi Photo Studio is a set of useful tools for easy photo processing. When you start Movavi Photo Studio, you will see a
launcher app that you can use to start and activate the photo applications. Click on an application name to launch the app.

 
Step 1: Prepare photos using Photo Batch
If you have lots of photos, you can start by organizing all of them at once.
 
Use Movavi Photo Batch for multiple photo processing:

•  Resizing multiple photos
•  Converting photos
•  Customizable photo renaming, adding date and time
•  Batch and individual photo rotating
•  Fully automatic image enhancements

 
Detailed Photo Batch instructions



 

 

Step 2: Edit individual photos in Photo Editor
After you've organized all of the photos, it's time to bring out the best in each photo with individual editing. Open the photos in
Movavi Photo Editor to retouch defects, remove unwanted objects, adjust colors, and more.
 
Use Movavi Photo Editor for all your basic photo editing needs:

•  Removing unwanted objects from photos
•  Image adjustments and auto-enhancements
•  Rotating, cropping, and resizing images
•  Adding text captions
•  Removing and replacing backgrounds

 
Detailed Photo Editor instructions

Step 3: Create a slideshow



 

 

What's a better way to show off your cool vacation photos than to make an animated slideshow. Organize your photos into a
storyboard, set the tone with background music, join the clips with transitions, and export the finished slideshow to share it with
your friends.
 
Create a slideshow in just a few steps:

•  Create a project
•  Add photos and videos
•  Edit slides
•  Add music
•  Join clips with transitions
•  Save the slideshow

 
Detailed Slideshow Creator instructions



 

 

Trial and activation

When you first install Movavi Photo Studio, all of its apps will be running in LIMITED TRIAL MODE. Trial Mode allows you to try
all of the features of the full version before you decide to buy it. After you buy Movavi Photo Studio, you can activate all of the
modules at once.
 
Limitations
In Trial Mode, the applications will have the following limitations:
 

LIMITED TRIAL VERSION FULL VERSION

Movavi Photo Editor  Saving photos is disabled  Save as many photos as you like

Movavi Photo Batch  You can only process up to 100
photos

 Process your entire photo library

Movavi Slideshow
Creator

 A trial version watermark is applied to
all videos

 Trial expires after 7 days

 No watermark
 Lifetime license

    Free updates
 Free tech support for all your questions about

photo and video
 Discounts on other Movavi products and

upgrades
 
Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase form.
IMPORTANT! Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from
support@movavi.com containing your activation key.

Step 2: Open the activation window
On the Movavi Photo Studio launcher, click the key icon, or open the Help menu in any of the Photo Studio apps and choose
Activate Software.

http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help
http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help


 

 

Step 3: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key. This requires an Internet connection to verify the key. If you don't have a
connection, you can use offline activation.

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the
activation process and restart the program.

Having problems with activation?
If activation is not working as expected, try the following:
•  Make sure that the activation key is entered correctly and is intended for your version of Movavi Photo Studio.
•  Try activating offline via e-mail.
•  Contact us at support@movavi.com and we'll help you solve the problem!
 
Activating without Internet access
Activation needs an Internet connection to verify the key. If the computer that you have installed Movavi Photo Studio on is not
connected to the Internet, you can activate the program via e-mail from any other computer or device.
Detailed instructions

mailto:support@movavi.com


 

 

Getting an activation key
You can get an activation key either from our official website or from any of our partners in your region. Follow the steps below to
buy an activation key from the Movavi website:
 
Step 1: Go to the purchase page
To open the purchase page for Movavi Photo Studio:
•  In the Movavi Photo Studio launcher, click the 'Buy all-in-one and save 40%' button
•  Or open the Help menu of any module and choose Buy Activation Key.
•  Or click here to open the purchase page

Step 2: Choose a license type
•  If you plan to use Movavi Photo Studio at home, click Buy Now on the purchase page to proceed with buying the personal
license.
•  If you plan to use Movavi Photo Studio at work, in a government institution, or gain profit in any way, click Business license on
the purchase page.

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our
vendor partners are secure and completely safe.
 

http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help


 

 

Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the
program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within the hour:
•  Check the Spam folder of your mailbox
•  Contact support

http://www.movavi.com/support/contact.html


 

 

Activating Photo Studio
Before you activate Movavi Photo Studio, all the apps will be running in LIMITED TRIAL MODE. By activating Movavi Photo
Studio, you can remove the trial restrictions and use the apps to the fullest! You will only need to activate all the modules once.
 
You will need:
•  Movavi Photo Studio activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a
key? Buy now
•  Internet access to verify the activation key. Don't have Internet access? See this guide on offline activation
 
Step 1: Open the activation window
1. Launch Movavi Photo Studio.
2. Click the key icon at the top of the window.

 
Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.
This step needs an Internet connection to verify the key. If this computer is not connected, you can use offline activation via e-
mail.

http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help


 

 

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the
activation process and restart the program.

If online activation fails, try the following:
•  Check that the activation key is entered correctly and is intended for the module you are activating.
•  Make sure you have administrator rights on your computer.
•  Try disabling your computer's firewall and antivirus software.
•  Try offline activation.
 
If you have any questions or problems while activating your Movavi software, please don't hesitate to contact our support team.

http://www.movavi.com/support/contact.html


 

 

Activating without the Internet
Activation requires Internet access to verify your activation key. If you don't have a working Internet connection on the computer
that Movavi Photo Studio is installed on, you can activate the program via e-mail using any other computer or device. You will be
asked to send us an automatically generated e-mail and then enter the reply into the program's Activation window.
 
You will need:
•  Movavi Photo Studio activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a
key? Buy now
•  A device or another computer that can be used to send and receive e-mail
 
Step 1: Open the activation window
1. Launch Movavi Photo Studio.
2. Click the key icon at the top of the window.

Step 2: Enter the activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

Step 3: Send an e-mail with the provided information

http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help


 

 

The next window contains important activation information that you will need to send us via e-mail to reg@movavi.com in order
to activate your program.

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer or
device that you will be sending the e-mail from.
 
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information
you've copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify
your activation key and send you an automatic response containing a registration key, which you will need to enter into the
Activation window. You should receive the server's reply within an hour.

Step 4: Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.



 

 

Once activation is complete, you may be asked to restart the application.

If you're having problems with offline activation:
•  Make sure that the keys are entered correctly and are intended for your version of Movavi Photo Studio.
•  Make sure you have administrator rights on your computer.
•  Contact our support team

http://www.movavi.com/support/contact.html


 

 

Photo Studio Launcher
The Photo Studio Launcher is your all-purpose photo editing portal. Use the Launcher to start the app you need, and to activate
or update all of the apps at once.
 
Launch apps
To start an app, click on its name in the launcher:
 
Photo Editor – edit individual photos, apply effects, add text, remove objects and cut out backgrounds.
 
Photo Batch – resize, crop, rename, and convert entire photo albums at once.
 
Slideshow Creator – join your photos into an animated slideshow with transitions and music.

Activating Photo Studio
If you see the words 'Trial version' next to your apps, it means that some features of the program are restricted until you buy
and activate Photo Studio. To activate Photo Studio:
 
1. Click the key icon at the top of the window.
 
2. The Activation dialog box will open. Enter your activation key into the box. If you don't have a key, click the Buy now link in
the dialog box and purchase an activation key from our website using any of the available secure payment methods.
 
3. Click Activate. You may then need to restart the application.
Detailed instructions on activation
Detailed instructions on activation without the Internet



 

 

Updating Photo Studio
If you have automatic updates enabled, you will be notified whenever you can get a newer version. To manually update Photo
Studio:
 
1. Click the question mark icon to open the Help menu.
 
2. In the Help menu, click Check for Updates. The 'Check for updates' window will open. Here, you can see if a new update is
available, read what's new, and download the new version.
 
3. If a new version is out, click Download to get the new version. The Photo Studio page will open, and the download will begin
automatically.
 
4. Once the download has finished, close Photo Studio if it is still running. Then, run the installation file and follow the wizard
instructions to install the new version.
Detailed instructions



 

 



 

 

Updating apps
Installing Movavi Photo Studio
To get all of the included photo editing applications, all you need to do is install the Movavi Photo Studio launcher app:
 

1. Click the button on the right to download the Movavi Photo
Studio installation package from the official Movavi website.

2. Run the downloaded file and provide administrator permissions
for installing the file. Then, follow the on-screen instructions
to install the software. During installation, you will be asked
to provide a folder to install Photo Studio and its included
applications. We recommend that you check that the selected disk
has enough disk space.
3. When installation has finished, the Movavi Photo Studio
launcher will open, providing access to all the photo editing
modules.

 

 
Updating Photo Studio
Movavi Photo Studio will notify you whenever a module can be updated to a newer version (the update notification can be
disabled in settings). To update Movavi Photo Studio and all of its apps:
 
1. In the Photo Studio launcher, click the question icon at the top to open the Help menu.
 
2. In the Help menu, choose Check for Updates. The update window will open.

3. In the update window, you can see if a new version is available and read what's new. If a new version is out, click the
Download button to get the latest version.
Minor updates (versions after the decimal point, i.e. 1.0.1 to 1.0.2 and 1.1) are absolutely free. Major version upgrades (i.e.
version 1.0 to 2.0) are offered at a discount and you can try the new version before you decide to upgrade.

http://www.movavi.com/download-photostudio
http://www.movavi.com/download-photostudio


 

 

4. The Movavi Photo Studio download page will open, and the download will begin automatically. Meanwhile, close Photo Studio
and any of its apps if they are running.
 
5. After the download has completed, run the downloaded file and follow the on-screen instructions to install the new version.
You may need administrator permissions to install the update.



 

 

Photo Editor
Using the Photo Editor, you can enhance and edit individual photos, apply

cool effects, add text, erase backgrounds and unwanted objects, and more.

Don't know where to begin?
Read the Quick start guide!

 
Basics:

Opening images            Saving images
 

Editing tools:
Rotating photos          Cropping photos          Resizing photos

 
Creative tools:

Adjusting photos          Adding effects          Adding text          Erasing objects          Cutting out backgrounds
 



 

 

Editing photos

Movavi Photo Editor is a versatile photo editing tool that can help you easily fix and enhance your photos and images.
 
 
Step 1: Add a photo
Drag and drop a photo from Windows Explorer onto the Photo Editor window, or click the Browse for Images button to open a
photo.
Opening images

 
Step 2: Erase unwanted objects
With Movavi Photo Editor, you can remove stray objects or strangers from photos:
1. Click the Object Removal tab on the right to show the relevant options.
2. Choose a selection tool, e.g. a brush
3. On the image, mark the objects you want to remove.
4. Click Start Erasing to remove the selected objects.
Erasing objects



 

 

Step 3: Remove and replace the background
1. Switch to the Background Removal tab.
2. Choose the green brush and paint a few strokes inside the foreground object.
3. Then, choose the red brush and paint a few strokes outside the object, marking the background that will need to be removed.
4. Photo Editor will then calculate the object's outline based on your selection. If it is not correct, add a couple more strokes of
each brush in problem areas and the outline will be adjusted automatically.
5. Click Cut Out to remove the background.
6. Now, you can choose the new background. You can keep a transparent background, fill the background with a color,
or import your own background image. Drag the object's frame inside the image to rotate and resize it relative to the new
background. 
7. Click Apply to finalize the changes.
Erasing backgrounds

 
Step 4: Enhance and adjust the image
1. Switch to the Adjust tab
2. Use Magic Enhance for an instant color and contrast adjustment
3. If you want to add a creative touch to the photo, you can manually set the color adjustment sliders.
Image adjustments

 



 

 

Step 5: Apply an effect
1. Switch to the Effects tab. The effects are sorted into groups. Click on a group's title to see the effects.
2. Choose an effect you like form the list. To cancel applying an effect, simply click the effect's thumbnail again.
Applying effects

 
Step 6: Add text and captions
1. Switch to the Text tab
2. Click Add Text to create a new text box in the image
3. Double-click the text box and enter your text
4. In the panel on the right, set the font, size, and color.
You can add as many text boxes as you like – simply repeat the above steps.
Adding text

 
Step 7: Edit the photo dimensions
The Rotate tab allows you to rotate and flip the image, as well as use a special straightening tool to fix an uneven horizon.
The Crop tab allows you to cut off the edges of the photo. You can use this to crop the image to the necessary proportions or
focus on the photo's subject.
The Resize tab allows you to shrink the image to the necessary size in pixels. This can be useful for making avatars, or
uploading images to the web.
Resizing photos



 

 

Batch resizing

 
Step 8: Export the finished image
1. Click the Export button.
2. Choose a location to save the new image.
Saving photos

 
 



 

 

Open images
How to open an image:
There are three simple ways to open an image for editing:
 
•  Drag and drop any image file from Windows Explorer or your desktop onto the Movavi Photo Editor window.
 
•  Click the Browse for Images button while on the start screen to browse for image files.

 
•  If you want to open the last file you've been working on, click Open last edited file on the startup screen of Movavi Photo
Editor.

See also:
Saving images



 

 

Adjust colors
The Adjust options allow you to manually adjust the photo's brightness, contrast, color, and other parameters. Click the Adjust
button on the right to open the image adjustments.

Magic Enhance
For an instant fix, click the Magic Enhance button. Movavi Photo Editor will automatically adjust the brightness and contrast of
your image.

Histogram
The histogram, located at the bottom of the Adjust tab, represents the distribution of colors and their shades in an image.
When you view  a histogram, it can give you information about how prominent a certain color is in the image, as well as about
its brightness and contrast. The left edge of the histogram contains the dark areas, while the light areas are on the right. For
example, if most of the colors are concentrated in the left-hand side, then the image is probably too dark, and vice versa. The
height of a color's graph represents its amount in the image. This way, you can use the histogram to aid you in adjusting the
image's colors.

Histograms of normal, underexposed, and overexposed images.
 
Above the histogram, you will find several groups of sliders. Each slider allows you to change a certain parameter of the image,
such as its brightness.
 
Brightness



 

 

Allows you to change the overall amount of light in the whole image, without changing any other parameters. When you increase
or decrease brightness, note how the histogram moves left or right, but maintains its original shape.
 
Contrast
Allows you to change the difference between the lightest and darkest parts of the image. This can help you make the image
more vivid, but too much contrast can cause unwanted posterization.
 
Saturation
Allows you to make the colors richer (positive values) or more subdued (negative values). Settings Saturation to -100 will make
the image grayscale. 
 
Hue
Allows you to change an image's overall color. Unlike tinting or color temperature (see below), changing an image's hue will not
color the picture in shades of one color, rather, it will shift all the image's colors in a given direction.
 
Temperature
Allows you to make the image feel warmer or colder, by adding orange or blue color respectively.
 
Tint
Allows you to add a red or green tone to the image, either for color correction, or for an artistic feeling.
Exposure
In photography, exposure is the amount of light that is allowed to reach the camera's sensor, which is usually achieved using a
combination of shutter speed, aperture, and lighting. If there is too much light on average, you may lose some details in the dark
parts, while the light areas may become 'washed-out', and vice versa. This allows you to imitate a higher or lower exposure, as if
you set it on your camera when taking the shot.
 
Gamma
Allows you to change how the middle tones appear on your image, without affecting the whites or blacks. 
 
Highlights and Shadows
These two sliders allow you to make each component more prominent in the image, and thus make the image darker or brighter.
 
Blur
Allows you to slightly blur the image to reduce noise or smoothen out defects.
 
Sharpness
Allows you to sharpen the image to bring out more details. Please be aware that oversharpening an image can add noise.
 
If you want to discard the most recent change, click the Undo button at the bottom of the screen.
If you want to cancel all the color adjustments, click the Reset button underneath the sliders.
 



 

 

Apply effects
Adding an effect allows you to add a creative touch to your photos and easily convey your emotions.

 
Step 1: Click the Effects button on the right to open the effects tab.

Step 2: You will see a list of effect groups. Click on a group to open it and show the relevant effects.
 
Step 3: Choose an effect you like and it will appear on the photo! You can also set the intensity of an effect by dragging a slider
under the effect icon right or left. To remove an applied effect, simply click on it once more.

To discard the latest changes, click the Undo button at the bottom of the window.



 

 

Rotate photos
The Rotate and Flip option allows you to flip, rotate, and straighten out images with slanted horizon levels. Click the Rotate
button on the right-hand side of the window to open orientation options.

Rotate and flip images
Use the buttons on the Rotate and Flip tab to rotate the image by 90 degrees or to mirror the image.
    

     Rotates your photo 90° counterclockwise      Flips your photo horizontally (left to right)

     Rotates your photo 90° clockwise      Flips your photo vertically (upside-down)

 
Straighten images
A tilted horizon is a frequent problem for both beginner and experienced photographers when shooting from a handheld camera.
This tool allows you to easily correct tilting in your photos, and you won't have to worry about horizon levels when taking your
pictures.
 
The Angle slider allows you to manually rotate the image up to 45° either way.
 
Using the Level Tool:
The Level Tool can help you automatically straighten out the image.
1. In your photo, find a straight horizontal or vertical line. This can be the horizon, the side of a building, or any other lines that
are parallel or perpendicular to the horizon.
 2. Now, click the Level Tool and trace that line on your image. Once you've traced the line, the image will be automatically
rotated to make that line exactly horizontal or vertical.



 

 

 
 



 

 

Crop photos
Cropping an image allows you to save it with a different aspect ratio, remove unwanted parts from the edges, and zoom in on
objects inside the image. We recommend that you save a backup copy of the image before cropping, in case you need the
original image later.
 
Step 1: Open the Crop tab
Click the Crop button on the right to open cropping options.

Step 2: Define size
Next, specify the size and proportions that you want. There are several ways to set the size:
 
Crop frame
A crop frame will be visible over the image. Drag inside the image to draw the cropping rectangle, or move the edges of the crop
frame with your mouse.



 

 

Pre-defined sizes
Open the drop-down box and select a suitable size from the list. Here, you can find some commonly used sizes and presets for
quickly changing the proportions of the image.

Manual input
If you need a specific size in pixels, you can manually enter the width and height into the corresponding boxes. To switch the
width and height, click the Invert Proportions icon.



 

 

Lock aspect ratio
Selecting this option will maintain the selected width to height proportions. This way, when you change one dimension of the
cropping rectangle (whether by drawing the cropping area or by entering a number for width or height), the other dimension will
change accordingly to keep the selected aspect ratio.
 
Step 3: Apply changes
Click the Apply button to accept the cropping changes. To discard the changes, click Reset.

Don't forget to save your image!



 

 

Add text
The Text option allows you to add text to your images. Use text to create image postcards, but remember – a picture is worth a
thousand words!

 
Step 1: Click the Text button on the right to switch to the Text tab.

Step 2:  In the Text tab, click the Add Text button. A new text area will appear in the photo.

Step 3: Click inside the text area and enter the new text.
 
Step 4: Choose a font, size, color for your text.



 

 

Step 5: Drag the text area with your mouse to place it inside the image. To rotate the text area or resize the text, drag at the

 resizing button in the bottom right-hand corner of the text area.
 
 
Removing text:

• 
 
Select a text area and click the  button in its upper left corner to remove just that one caption.

•  To remove all captions, click the Remove All Text button in the Text tab right under font properties.



 

 

Resize photos
Resizing images allows you reduce an image's file size, prepare pictures for uploading to web albums, which often have a size
limit, or prepare web-sized images for blogs and websites. If you intend to make other edits to the photo, it is best that you do
them prior to resizing it, since the image quality will then be preserved better. Also, we recommend that you save a copy of the
image before resizing in case you may need it later, especially if you plan on printing out the image.
 
Step 1: Go to the Resize tab
On the right-hand panel of the window, click the Resize button to switch to the Resize tab.

Step 2: Enter new dimensions
Select or enter the necessary image size:

•  The Fit into box allows you to select from the most common image sizes, as well as presets for printing and exporting
images. 
•  To enter a custom image size, enter the dimensions into the width and height boxes. You can change the
measurement unit in the box on the right. The default unit is pixels.
•  To avoid visual distortions of the image after resizing, keep the Constrain proportions option enabled.



 

 

Step 3: Apply changes
Finally, click Apply to resize the image to the specified size. Don't forget to save the image when you're done!



 

 

Erase objects
The Object Removal tool can help you erase unwanted objects or people from your images. Movavi Photo Editor uses a special
algorythm to reconstruct the background as if the deleted objects were never there. All you need to to is mark the objects you
want to remove.

 
 
Step 1: Switch to the Object Removal tab.

 
Step 2: Choose a selection tool
There are several selection tools available for your convenience:

Use the Brush to freely paint the red selection
area. The Size slider below will set the brush size

Use the Eraser to deselect parts of the image. Just like
with the brush, you can change eraser size with the slider
below.

Use the Magic Wand tool to select adjacent areas
of uniform color in a single click.

Use the Clone Stamp Tool to select a part of the image
to transfer onto another part of the image. You can
use the Clone Stamp Tool to mask small blemishes or
duplicate objects.

Use the Lasso tool to outline an object. Click the arrow on the lasso icon to change the type of lasso:



 

 

The default Freehand Lasso allows you to freely
draw the object's outline.

The Polygonal Lasso allows you to outline the object
with straight lines.

 
Step 3: Mark unwanted objects
Using the selected tool, mark the objects you want to delete in the image. You can mark and delete all the objects at once or one
after one. When selecting people and objects, don't forget about their shadows and reflections.

The people marked with red will be removed from the image.
 

If you need to make the selection larger or smaller on all sides, use the following keyboard shortcuts:
Ctrl+Shift+P to expand the selection
Ctrl+Shift+M to contract the selection

 
Step 4: Set Variation
When you remove an object, the program will recreate the background by using pixels from the rest of the image. Variation
affects how far away from the object the replacement pixels can be taken from. For lower variation values, the replacement
pixels will be taken from the area only directly adjacent to the object, while at 100 they can be taken from any part of the image.
 
Different variation values will provide different results depending on the size of the object, its background, and the overall
uniformity of the image. Try out a few values to see which works best for your pictures.
 

For example, in this image it would be best to select a lower variation so that the sea is not cloned onto the sand.
 



 

 

Step 5: Erase!
Click the Start Erasing button to begin processing. Please note that erasing objects with high variation values will take slightly
longer. If you aren't satisfied with the result, you can click the Undo button and adjust your selection or choose a different
variation value. Repeat steps 3-5 to remove any other objects you want.

Step 6: Clone retouching
If there are some more small defects left over after erasing, you can manually correct them with the Clone Stamp tool. You can
select a patch of the image and copy it over the defects.
 
1. Select the Clone Stamp tool. Choose the stamp size and softness (how smooth the edges of the stamp should be).
2. Hold down the Alt key and click onto the part of the image that you want to clone. Usually, it should be close enough to the
blemish so that the copied spot is similar to the original in color and texture.
3. Paint over the blemish with the copied sample. The source will also move as you paint with the stamp, in order to give a more
natural look to the edited parts.
Learn more about clone retouching



 

 



 

 

Cut out the background
Movavi Photo Editor can help you quickly and easily cut out people and objects from any background. You can use it to create
product photos, funny collages and more.

 
 
Step 1: Cutting out the Background

1. Mark the foreground and background areas:
Use the tools to specify which parts of the image belong to the object you want to keep, and which belong to the background
and must be clipped away.  
 

The green Foreground Brush lets you select the object you want to keep. Paint a few strokes inside the object(s) to
mark them as the foreground. There is no need to color the entire object, as Movavi Photo Editor uses a smart edge
detection algorythm.
The red Background Brush lets you mark the background, which needs to be erased. Swipe a few strokes of the red
brush on the background around your object. Pay closer attention to parts of the background that have similar color or
pattern to that of the foreground.



 

 

The Eraser lets you erase both red and green selection in case you make a mistake.

 
Now that you've marked the foreground and the background areas, a yellow border line will appear around your object.
Sometimes, with complex shapes or background patterns, you may need to add a few more strokes of each brush to specify the
border line. For higher precision, try zooming in on the image and using a smaller brush size.

 
 

2. Set Boundary Smoothness:
Sometimes, due to the complexity of the background or the object's shape itself, the yellow boundary may seem a little 'jagged'
where it shouldn't be. To reduce this effect, you can set the Boundary Smoothness so that the borderline looks more natural.
Likewise, if there are many small details on the edges of the object, select a low smoothness to preserve their shape.

 
 
3. Cut out the background
When the yellow border completely encompasses the object you want, click Cut Out to clip away the background. The
background will be removed, and you can proceed to the next step, where you can choose a new background. If you want to
return to editing the selection, click Step 1: Select Foreground tab to show your selection and the selection tools. Once you've
adjusted the selection, simply click the Cut Out button once again to proceed.

 
 
Step 2: Set the New Background
When you click Cut Out, you will be switched to Step 2, where you can select a new background for you image and move the
cut out objects as you like.
 

 
1. Choosing a background color or image
In this step, you can choose what you'd like to use as the new background for the object you've cut out.



 

 

Transparent:

If you want to keep a transparent background, choose the 'transparency' icon to the left of the color palettes .
 
Grayscale colors:
To use a standard white, grey, or black background, choose one of the color icons.
 
Custom color:
To choose a different color, click the arrow on the rightmost color sample to open the palette. Click More in the palette to open
the standard color selection dialog box where you can mix a custom color.

 
Image:
To open an image to use as the background, click the Image File button and select the file you want to use. It will then be added
as the new background.
 
2.  Feather Radius
If the object has uneven edges or color noise along the edges, you can use feathering to slightly blur the edges and make a
smoother transition from the object to its new background. Drag the Feather Radius slider to set the necessary blurring level.
 
3.  Move the object:
Click and drag your object to move it anywhere you want in the image. If the object is much smaller than the original image size,
you can later crop the image.
 
Step 3: Apply the changes
Finally, click Apply to accept the changes. Please note that if you switch to another tab while removing a background, your
selection will be lost.
 
Don't forget to save your edited image!
 
 



 

 

Clone stamp retouching
Located on the Object Removal tab, the Clone Stamp tool can help you manually correct small blemishes, remove wrinkles, or
clone (copy) objects on an image.
 
Step 1: Select the Clone Stamp tool
Switch to the Object Removal tab, and click the stamp icon in the toolbar to select the Clone Stamp tool.

Step 2: Set the stamp size and softness
Use the Size slider beneath the tool icons to set the stamp's size.
Increasing Softness will make the stamp's edges more transparent, which can help you blend the stamped parts with the rest of
the image.
 
Step 3: Pick a source
Move your mouse pointer over to the area that you want to clone. Hold down the Alt key and click on the image to define a
source point.
 
Step 4: Paint over the target
Release the Alt key. Then, move your mouse pointer to where you want the cloned fragment to appear and paint over the area
you want to replace. As you move your cursor while painting with the stamp, the sampled area will also move relative to your
cursor position.
 
To discard the latest changes, click the Undo button at the bottom of the window.



 

 

Save images
How to save an image:
1. Click the Export button in the bottom right-hand corner or open the File menu and click Save to rewrite the previous image,
or click Save As to save the image under a different name.
 
2. In the Save File dialog box, choose where you want to save your image.
 
3. If you want to save the image in a different format, open the Save as type list and select the format you want.
Learn more about changing image format
 
4. Finally, click Save.



 

 

Print images
Follow these simple recommendations to print out high quality images from Movavi Photo Editor.
 
1. Make sure the image is large enough for printing on the selected paper size, and conversely, choose the right paper size for
your images. If you print out small images on large paper, you may find that you can see individual pixels or that the image is not
smooth enough on print. Before taking the photos you want to print, use a camera with a high megapixel count, make sure that
it is set to the highest available quality (some cameras allow you to shoot smaller images than the camera's maximum size), and
provide good lighting conditions to minimize noise.
 
The larger the original photo, the larger a print size you can afford without losing crispness and quality. The standard for printing
images is to have at least 300 pixels per inch of the photo paper. The following table shows the correlation between image size
and its printed size when printed at 300 pixels per inch (~118 pixels/cm). You can use it to match paper size to your image size
and vice versa.
 

Camera Megapixels Image Size in Pixels Printed Size in Inches Printed Size in Centimeters
2 1600 x 1200 px 5" x 4" 13 cm x 10 cm
3 2048 x 1536 px 7" x 5" 17 cm x 13 cm

4 2464 x 1632 px 8.2" x 5.4" 21 cm x 14 cm

5 2560 x 1920 px 8" x 6" 21 cm x 16 cm
6 2816 x 2112 px 9" x 7" 24 cm x 18 cm
8 3264 x 2468 px 11" x 8" 28 cm x 21 cm
10 3872 x 2592 px 12.1" x 9.1" 33 cm x 22 cm
12 4000 x 3000 px 13" x 10" 34 cm x 25 cm
 
If you didn't find the necessary size in the table, you can easily calculate the printed size in inches (1 inch = 2.54 sm) by dividing
the width and height in pixels by 300. Likewise, to find out the minimum number of pixels for a certain print size, multiply the
width and height in inches by 300 to get the image dimensions in pixels.
 
2. You do not need to downsize the image before printing: the software will automatically fit the image onto the selected paper
size. Downsizing the image will only reduce quality.
 
3. If you need to crop unwanted parts of the image, make sure that the end result is not too small. If you have a very large
image, you can use the crop function to zoom in on objects in the image (don't forget save cropped file as a new image in order
not to lose the original one!), but keep in mind that the output image size must be large enough for printing. You can check the

image size in pixels by looking at the File Information  button on the bottom panel. You can learn more about edited file by
clicking on this button.
 
4. Use a high quality printer for printing out your photos. These simple guidelines will help you choose a printer:
•  Inkjet printers are much better at printing images than laser printers. Dye sublimation printers are considered the best for
printing photos, however they are quite rare and can only be used for photo printing.
•  Check the printer's dots per inch (DPI) resolution: the higher the DPI, the higher quality prints it will be able to produce. For
photo printing, make sure that the printer has at least 300x300 DPI.
•  Generally, a dedicated photo printer will produce better results than a general-purpose multifunction printer of the same price
range.
•  Some printers may produce colors different from the original because of the way they convert RGB color (the color scheme you
see on your monitor) to CMYK color (used for printing).
•  Be aware of your printer's maximum print size; many consumer printers only print photos up to 8 by 10 inches (20.32 x 25.4
cm). You should find this information on the packaging or in the printer's user manual.
 
*You can get the information about your printer properties on the device itself, in printer User's manual, on a box or on
manufacturer's web page.
 
5. Use high quality photo paper. There are different kinds of photo paper that may work differently depending on the content of
your image. For example, glossy paper is better at reproducing bright colors, while matte paper is more suitable for portraits.
Also, make sure that the paper matches your printer type (i.e. laser or inkjet).



 

 

 
Calibrating your Display
The colors you see in print may be slightly different than those you see on your display due to LCD monitor specifics. You can try
to calibrate your display for better previewing:
1. Open the Control Panel
2. Type "Calibrate display" into the search box.
3. Click Calibrate display color. This requires administrator permissions.
4. Follow the onscreen instructions to calibrate your display.
 
Printing the Image
To print out an image from Movavi Photo Editor:

1. Open the File menu and choose Print.
2. Choose the printer you want to use for printing the photo.
3. Click Settings to open the settings for the selected printer. The settings will vary depending on your printer's
software, but generally you can choose paper size, orientation and color options.
4. Choose the number of copies that you want to print. If this is your first time printing a photo, you may want to first
print only one sample copy to make sure you have set up everything right.
5. Click Print to send your image to print queue. The printing process should begin shortly. The time needed to print an
image heavily depends on the size of paper, resolution and complexity of the image and on set photo printing quality.

 
 



 

 

Change image format
Changing an image's format allows you to use your images in a wider variety of situations, compress the images to a smaller file
size, and work with transparency. Many websites only allow a limited number of formats for uploading, so having a tool to easily
change image format becomes a must.
 
How to change image format in Movavi Photo Editor:
 
1. Open the image you want.
 
2. Click Export in the bottom right-hand corner of the window. The Save File dialog box will open.

3. To choose an image format, open the Save as type box and select the format you need.
•  If the format lists multiple file extensions, such as *.jpg, *.jpeg and others for JPEG, you can type the necessary file extension
in the file name field.
•  If your image contains transparent areas (for example, after removing a background), please note that not all formats support
transparency. If you want to retain transparent areas after saving the image, choose one of the following formats: BMP, PNG,
DPX, TGA.
 
Advanced:
Some formats also allow you to set image quality and compression method. For these formats, click the Options button in the
Save File dialog box to open these options.

JPEG Quality
Drag the slider to the necessary quality level and click OK. Lower quality allows you to compress the image to a smaller file size,
but will probably not look as good.
 
TIFF Compression



 

 

Select the preferred compression method:
•  Uncompressed: no compression method will be used. The image will be much larger in size than its compressed copies, but
uncompressed images with large resolutions may be processed faster by some software.
•  PackBits: offers less compression than LZW, but is the most widely supported compression method, especially on Apple
software.
•  LZW: compresses the image to about half size.
•  ZIP: best for working with 16-bit images and average for 8-bit images.
Click OK to apply changes.
 
4. Choose where to save the new file and give your file a name.
 
5. Click Save.
If you make any edits after saving the file in a different format, you will be working with the new file.
 



 

 

Photo Batch
Using Movavi Photo Batch, you can edit lots of photos at once.

Don't know where to begin?
Read the Quick Start Guide!

 
Basics:

Opening photos     Previewing      Batch export
 

Editing tools:
Resizing photos     Converting photos     Renaming photos     Rotating photos     Color adjustments



 

 

Batch editing

Movavi Photo Batch can help you process multiple photos with the same settings and organize your photo collection.
 
Add files
Drag and drop the files you want to edit from Windows Explorer, or use the +File and +Folder buttons to add individual files and
entire folders.

 
Adjust photos
Switch to the Adjust tab and choose the enhancements you want to apply to the photos. Use the automatic contrast and white
balance adjustments, or click Magic Enhance for a fully automatic color correction.
Batch adjustments

Rotate images
To rotate individual images, hover your mouse pointer over an image's thumbnail and click the Rotate button.



 

 

To rotate all images in the list, go to the Rotate tab and choose the necessary rotation angle.
Rotating lots of images

Rename images
If you have several photo sets from different cameras, or if you want to clean up your photo archive, you can set a template to
rename all images in the list. Go to the Rename tab and choose how you want to rename the files. You can number your photos
for efficient sorting, make uniform filenames for all of your photos, and label them with the date and time when they were taken.
Batch renaming

Resize images
Use the Resize tab to scale all of the photos to the same size.
Resizing and scaling images



 

 

Convert images
The Format and Quality options let you save the photos in a different format and manage their quality.
Converting images

Export images
Finally, when you have reviewed all the settings, click the Batch Export button and choose where you want to save the
processed images.
Export images



 

 

 
Trial limitations
When you first install a copy of Movavi Software, it will be running in LIMITED TRIAL MODE. In Trial Mode, you can try all the
features, but you will only be able to process up to 100 photos.
Get an Activation key
 
If you have already purchased the program, all you need to do is activate it using the key you received after completing the
purchase.
Activation guide

http://www.movavi.com/movaviphotosuite/buynow.html?asrc=ps_help


 

 

Open photos
To open lots of photos at once for batch editing, use one of the following ways:
 
•  Click +Files to add several files from the same folder.
•  Click +Folder to add the contents of a whole folder or several folders.
•  Open Windows Explorer and drag the files you want to edit onto the Photo Batch window.

Removing photos from the list
Perhaps you don't need to edit all of the photos that you've added from a folder. To remove a photo:
 
1. Hover your mouse over the photo you want to remove.
 
2. Icons will appear on top of it. Click the Remove button to remove the image from the list.



 

 

Resize photos

The Resize tab allows you to make all of your photos fit certain size dimensions.
 

 
1. Click the Resize tab on the right to open resizing options.
 
2. Open the list and select a resizing method:
 

Keep original size: all images will retain their original size.
 
Scale to width: all images will be scaled to match the specified width. The height for each image will be calculated
based on its original proportions.
 
Scale to height: all images will be scaled to match the specified height. The height for each image will be calculated
based on its original proportions.
 
Scale by percentage: all images will be scaled based on specified percent, maintaining original proportions.
 
Scale to size: scales all images to the specified dimensions, maintaining their proportions.
 
Maximum size: scales all images down to fit inside the specified dimensions. If an image is already smaller than the
maximum size, it will remain unchanged, while larger images will be scaled down.
 
Custom size: allows you to freely set the size for all photos, without maintaining proportions.

 
3. Enter the new dimensions into the respective fields.



 

 

Convert photos

The Format and Quality tab allows you to convert images from one format into another.

1. Switch to the Format & Quality tab in the right-hand side of the window.
 
2. Open the list of formats and choose the format you'd like to convert the images into.
 
3. Some image formats allow you to change the compression level for saving the images – this way you can manage the
balance between file size and quality:

•  JPEG: drag the quality slider to set the necessary quality. The higher the quality, the larger the output file will be, and
the lower the quality, the more likely the image will have visual artefacts, such as off colors or pixellization.
•  TIFF allows you to select one of the available compression methods:

•  Uncompressed: no compression method will be used. The image will be much larger in size than its
compressed copies, but uncompressed images with large resolutions may be processed faster by some
software.
•  PackBits: offers less compression than LZW, but is the most widely supported compression method,
especially on Apple software.
•  LZW: compresses the image to about half size compared to the same uncompressed image.
•  ZIP: best for working with 16-bit images and average for 8-bit images.



 

 

Rename photos

In the Rename tab, you can choose a template for renaming all of the currently open images. You can change the original
name, number your photos, or add a date or free text to the photos.

Rename tab
Numbering your photos:
1. Switch to the Rename tab.
 
2. Open the Renaming Mode list and choose Add index or Add counter:
•  Add index – adds a simple number to each photo in the following format: 1, 2, 3, 4, 5, 6... Most file managers do not sort such
sequences correctly, listing 10 after 1.
•  Add counter – adds a number with leading zeroes to each photo in the following format: 001, 002, 003, 004... This format
allows file managers to correctly sort  the photo series. 
 
3. In the Where option, choose whether you want to add the number before or after the original file name.
 
4. If your photo series does not start from the beginning, you can set the first number in the Start from field.
 
5. If you also want to change the main part of the file name that comes before or after the number, select the Replace name
with option, and enter the new file name into the corresponding field. This is especially helpful if the old filename already
contains numbering, but it is incorrect, or if you've deleted some photos but want the numbering to stay intact.



 

 

Adding date and time:
1. Switch to the Rename tab.
 
2. Open the Renaming mode list and choose Add date. The date is extracted from the photo's EXIF data and shows the date
the picture was taken or created.
 
3. In the Where option, choose whether you want the date to be appended before or after the original file name.
 
4. In the Format list, choose whether you want to add the date, time, or both.
 
5. If you also want to change the main part of the filename, select the Replace name with option, and enter the new name into
the corresponding field. This way, you can name the photos after the location where they were taken. 

Adding text to the file name:
1. Switch to the Rename tab.
 
2. Open the Renaming mode list and choose Add free text.
 
3. In the Where option, choose whether you want the text to be appended before or after the original file name.
 
4. In the Text field, nter the text you want to append to the file name.
 
5. If you need to completely replace the old file name, select the Replace name with option and enter the new name.



 

 

Rotate photos

Use the Rotate tab to rotate the images by 90 degrees and mirror all of the images in the list.

Rotate tab
 

Rotating all images:
The Rotate tab contains options for rotating or flipping all currently open images. Click the corresponding button to rotate the
image to the necessary angle.
 

Keep the original orientation of images

Rotate the images 90° clockwise (to the right)

Rotate the images by 180°

Rotate the images 90° counterclockwise (to the left)

You can select only one rotation option at a time.

Flip all of the images horizontally (upside-down)

Flip all of the images vertically (left to right)

You can combine one or both flip options with one rotation option.

 
Rotating individual images:
If you only need to rotate one or several images, you can rotate the photos one by one. To do that, hover your mouse pointer
above the image you want to rotate and click the Rotate button on the image's thumbnail. You can also rotate images from the
Preview window.



 

 



 

 

Adjust photos

The Adjust tab allows you to apply instant automatic enhancements to all of the images. Movavi Photo Batch will automatically
analyze the photos and use the most appropriate levels of brightness, contrast, saturation, and white balance to help you
achieve perfect photos.

Adjust tab
Magic Enhance – automatically adjusts the brightness, saturation, and white balance of all photos.
 
Auto Contrast – automatically fixes the contrast for all images.
 
Auto White Balance – automatically detects the white balance in the photos and shifts the lighting in the photos to make them
look more natural.
 
You can select both Auto Contrast and Auto White Balance at the same time, or use Magic Enhance to make fully automatic
adjustments.



 

 

Preview images

When you open a photo series in  Movavi Photo Batch, you can see all of the photos at a glance in the file list. However, you can
also view the photos individually in a larger size.
 
Opening the Preview window:
1. Hover your mouse pointer over an image in the file list. The View, Rotate, and Remove buttons will appear.
2. Click the View button to open the selected image in a larger preview window.

The Preview window:
In the Preview window, you can view the image in a larger size and manage images in the file list.

Use the following buttons to manage the preview:
 

Sets a zoom level at which the entire image fits inside the preview
window

View the image in its actual size

Remove the image from the file list



 

 

Move between photos in the file list

Rotate the photo 90° counterclockwise or clockwise

Hold down this button to view the original image, before applying
any settings or effects.



 

 

Export photos

After you've selected the necessary adjustments for your photos, it's time to export them.
 
Step 1: Open the Export window
Click the Batch Export button in the bottom right-hand corner of the main window to open export options.

Step 2: Choose where to save the files
Choose one of the available options of saving the processed photos:
 
•  Save to new folder – the processed photos will be stored in the folder specified in the field below.
 
•  Save to original folder and back up originals – the original photos will be moved to the folder specified in the field below,
while the processed photos will be stored in the original folder.
 
•  Replace originals – the processed photos will be saved to the original folder, while the original photos will be deleted. We
recommend that you only use this option if you are sure you will not need the original photos.
 
•  Rename and save next to the originals – Both the original photos and the processed photos will be stored in the same
folder. The processed photos will have a number, e.g. '(1)' added to the file name.
 
Step 3: Start exporting
Finally, Click OK to start the exporting process. This may take up to a couple minutes if you are working with many large photos.



 

 

Slideshow Creator
Using Movavi Slideshow Creator, you can arrange your photos into an animated slideshow with music and transitions.

Don't know where to start?
Read the Quick Start Guide!

 
Step 1: Create a project

Step 2: Add files
Step 3: Edit slides
Step 4: Add music

Step 5: Add transitions
Step 6: Save your slideshow



 

 

Movavi Slideshow Creator
Quick Start Guide

Movavi Slideshow Creator lets you create video slideshows with your photo albums, complete with background music and
smooth transitions.
 
Step 1: Create a project
When you first start Slideshow Creator, you will be asked to choose an aspect ratio for your slideshow. This depends on the
proportions of the photos you'll be using. Most modern monitors have a 16:9 aspect ratio.
You will be able to change this later.
Learn more about creating a project and aspect ratio
 

 
Step 2: Add files
In the Video & Photo tab, click Add Videos and Photos to choose the files you'll be using, or click Add Folder to add an entire
photo album.
Learn more about adding mediafiles



 

 

Step 3: Arrange files
The clips you add will be placed onto the Storyboard in the same order as you added them. To rearrange the files, simply drag-
and-drop their thumbnails onto the correct place relative to the other clips.

Step 4: Set slide duration
By default, all photo slides will be shown for four seconds each. To change that, click the cogwheel button to open Clip
Properties, and enter a new Image Slide Duration.

Step 5: Add music
Next, switch to the Audio tab, where you can add background music. We've included a few pre-made songs that you can use in
your projects. To add your own songs, click Add Audio Files and choose the audio files you want to add.
 
The tracks will be played in the same order as they appear in the list. To trim a track, start playing the song, and click the left or
right bracket button to trim it from the beginning or from the end, respectively.
Learn more about adding background music



 

 

Step 6: Choose transitions
Switch to the Transitions tab, where you can choose animations to smoothly join the slides.
 
Select the transitions you like from the list – click on a transition to preview it in the player, and Ctrl+click to select multiple
transitions. Then, set the duration for each transition, and click Apply to accept the changes and add the transitions to your
slideshow.
Learn more about adding transitions

Step 7: Export your slideshow
Make sure to save your work once in a while: choose Save from the File menu to save the slideshow project so that you can
access it later.
 
When you're done with the slideshow, click the Export button to open the exporting options. In the Export window, choose a
format you want to save the video in, and name your slideshow. Finally, click Start to begin processing the video. Your slideshow
will be ready in a few minutes.
Learn more about saving slideshow



 

 

 
 
 
 
 



 

 

Create a project
When you open Movavi Slideshow Creator, you will be offered to create a new slideshow project.
 
Creating a new project
1. To start a new project, open the File menu and choose New Project. You will see the same window as you did at startup.

2. In the New Project window, choose the aspect ratio for your new project. The aspect ratio defines the proportions of the
video. Click 16:9 or 4:3 to select the aspect ratio that best suits your needs.
•  16:9 is commonly used for widescreen video, and most computer monitors and TVs also use this aspect ratio.
•  4:3 is very commonly used in photo cameras. Chances are, most of your photos also have this aspect ratio, so you will be able
to fit the photos inside the video frame without black bars. Furthermore, Apple iPads also use this aspect ratio, so you will be
able to view the slideshow on these devices.

Visual comparison
3. Finally, click OK to start working on your project.
 
Saving projects
You can save your work on the slideshow in a project file, which you can open later to continue working on the slideshow. To do
that, open the File menu and choose Save Project. You will be asked to specify a location and a name for the project file.

 
Please note that the project file can only be opened using Movavi

Slideshow Creator. If you want to save the slideshow as a video file
that can be shared and viewed in players, use the Export button.

 
Opening projects
To open a previously saved project, open the File menu and choose Open Project.

Troubleshooting
Files are missing from the project
When you open a previously created project, you may see a message saying that a file is missing from the project. This may
happen if one of the files used in the project has been moved somewhere else? renamed or deleted from disk.



 

 

•   If the file was moved elsewhere or renamed, click the Browse button and locate the file in the Windows Explorer window. After
that, you can continue working on the project as usual: the file will be restored in its place on the timeline, as well as any other
changes you have made.
•   If the file was deleted or you no longer wish to use it in the project, click Skip to open the project without the missing file.
•   To cancel loading the project, click Cancel.

Something has gone wrong and my project was not saved
If Movavi Slideshow Creator was closed unexpectedly and you didn't save the latest changes, you can try restoring them from
an autosave.
1. Open the '\My Videos\Movavi Slideshow Creator\Projects' folder of your user.
2. Find the 'autosave*.mep2' file in this folder and check the date and time when it was created and last modified.
3. If the date and time of the autosave suits you, open this file in Movavi Slideshow Creator and you can continue working on
your project.



 

 

Add mediafiles
To begin working on your video project, you will first need to add some media files to the Slideshow Creator.
 
1. Open the Video & Photo tab. If you have just launched Slideshow Creator, the tab is already opened for you.
 
2. Click Add Videos and Photos to add one or more media files from a single folder, or click Add Folder to add all the contents
of one or more folders.

The files will then be added onto the Storyboard in the same order as you added them, and in the same order as they appeared
in the Windows Explorer window. After that, you can simply drag-and-drop the files on the Storyboard to reorder them.

 
Also, you can drag-and-drop media files onto the Storyboard straight from any Windows Explorer window. For adding audio files,
please see the 'Add music' section.
 



 

 

Edit slides
 
Slide length
To change the duration of each image in your slideshow:
1. On the Storyboard, select the image that you want to edit.
2. Click the cogwheel button on the toolbar to open Clip Properties.
3. In the Clip Properties window, set Image Slide Duration to the necessary length.
4. Click OK to accept the changes.

Rotating images
1. On the Storyboard, select the slides that you want to rotate.
2. Click the Rotate button on the toolbar.
To rotate multiple slides at once, select them while holding down Ctrl key, and then click Rotate button.

Cutting clips
1. Move the progress marker onto the moment where you want to cut the clip.
2. Click the Scissors icon on the toolbar.



 

 

If you want to cut out a part of a clip, repeat the same steps to cut at the beginning and at the end of the unwanted fragment to
cut it off into a separate clip. Then, select this clip and click the Trash can icon on the toolbar.

 
Enhancing images
Using the automatic adjustments in Slideshow Creator, you can quickly improve most photos.
1. On the Storyboard, select the clips that you want to enhance.
2. Click the Magic Enhance button to apply automatic color adjustments to this clip.
 
You can find more adjustment options under Clip Properties (cogwheel button).



 

 

Remove black bars
Sometimes, when you add photos to the slideshow project, you may notice that some or all of them have black bars at the sides
or at the top and bottom. This can happen because the photos and videos have different proportions. While all slides need to
fit into a frame of the same size, some photos will fit in nicely, and other photos that have different proportions, will have some
space left over, showing black bars underneath.
 
Solution A – Change the aspect ratio
This solution will help if all or most slides have black bars around them. To solve this, we will change the proportions of the entire
project to fit the photos you're using.

1. Click the pencil icon  at the bottom of the window next to Project Settings. The Project Settings window will open.
 
2. In the Frame Size box, note the current resolution and aspect ratio. Then, open the box, and select a similar resolution with
a different aspect ratio. For example, if you had the 1280x720 (aspect ratio16:9) frame size, choose the 1280x960 (aspect ratio
4:3) frame size.

 
Or, if you know the exact sizes of your photos, you can enter the width and height into the corresponding boxes below.

 
3. Click OK to accept the changes and preview the slideshow to see if this helped.

Solution B – Use automatic cropping
This solution will help if many of the slides have black bars around them and you don't want to change the aspect ratio.
Automatic crop will resize all of the images to cover the entire screen, and trim away the edges of the videos that had black bars.

1. Click the pencil icon  at the bottom of the window next to Project Settings. The Project Settings window will open.
 
2. In the Resize Method box, choose the Crop option.

 
3. Click OK to accept the changes.



 

 



 

 

Add music
Adding music to your slideshow can set the right mood and tempo for the entire viewing experience.
 
Step 1: Go to the Audio tab
Click the note button to switch to the Audio tab, where you can add and manage the soundtrack of your slideshow.

Step 2: Add audio tracks
Click Add Audio Files and choose the music files that you want to use in the slideshow.
If you don't have suitable audio files on your computer, you can use the cool audio tracks that come with Slideshow Creator. To
do that, click 'Select one of our tracks' and select music that fits the mood.

The tracks will now be listed in the Audio tab. Here you can play back and manage the tracks.
 

 Play – allows you to play back the audio file. When you click the Play button, a progress bar will appear beside the

file. Click the Stop  button to stop playback.

 Volume – allows you to change this track's volume in the project, and how loud the track will be in the output file.

 Delete – removes this track from the project.



 

 

 
Step 3: Trim or loop audio
Most likely, the added tracks will not be of exactly the same length as the video project.
 
Looping Audio
By default, if the background music is shorter than the video, there will be silence until the end of the video. To repeat the audio
tracks from the beginning, select the Loop audio option. The audio tracks will then play in succession until the end of the video. 
 
Trimming Audio
If the audio is longer than video, the background music is automatically cut off at the end of the video, but you can also trim each
individual track from the beginning or from the end.
 
1. Click Play for the song you want to trim. The song will start playing from the beginning.

2. When the progress marker is at the moment where you want the song to begin, click the left bracket button to trim the song
from the beginning.

3. When the progress marker is at the moment where you want the song to end, click the right bracket button to trim the song
from the end.

Trimmed songs will be marked with a highlighted bracket icon, and the trimmed parts will be skipped when playing back the
video. To cancel trimming for a song, click the Play button and click the brackets again to disable them.
 
Step 4: Mix volume levels
You can change both the volume of the background audio, and the volume of individual video clips.
 
Changing Music Volume

1. On the Audio tab, click the volume icon  next to the track you want to edit.
2. A volume slider will pop up: drag the slider to the necessary level and then click anywhere else to hide the slider.
 
Changing Video Volume
1. Select the video you want to edit.
2. Click the Clip Properties button to open the settings for this clip.
3. In the Clip Properties window, drag the Video Volume slider to the necessary level.
4. Click OK to close the window and accept the changes.



 

 

You're done! Now your video or slideshow has some great music.

[1] Stock Audio Tracks:
Stock audio tracks are copyright of their respective owners and are free for both personal and commercial use with credit
attribution under the Creative Commons license.
Adventure
"Coulda Shoulda Buddha" by UncleBibby
Available on the Free Music Archive (freemusicarchive.org)
Under CC BY license

Mystic
"Lunar Dunes" by Spinning Clocks
Available on the Free Music Archive (freemusicarchive.org)
Under CC BY license

Romantic
 "The Wrong Way" by Jahzzar
Available on the Free Music Archive (freemusicarchive.org)
Under CC BY-SA license

Travel
"Nobody Here But Us Charles Dickens" by UncleBibby
Available on the Free Music Archive (freemusicarchive.org)
Under CC BY license

 

http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/


 

 

Add transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way. Follow the
steps below to add transitions to your video project.

 
Step 1: Switch to the Transitions tab.

Step 2: Choose transition styles
From the list of transitions, select the ones that you want to use in your slideshow. Clicking a transition name will show its
preview in the player.
•  To select several consecutive transitions, click the first transition and then hold down the Shift key as you select the last
transition in the sequence.
•  To select several non-consecutive transitions, hold down the Ctrl key and click on each transition.
•  To randomize transitions, click the Select All button at the top.

 
Step 3: Set duration
In the Duration field, enter how long you would like each transition to last. This value will be the same for all transitions.
 
Step 4: Click Apply to accept the changes.



 

 

If you want to remove all transitions, click Clear Transitions. If you want to exclude a transition style from being used in your
project, simply deselect it in the list and click Apply.



 

 

Save slideshow
Once you've finished with the slideshow, it's time to save it in a format that can be viewed in media players.
 
Step 1: Click Export
Click the Export button in the bottom right-hand corner of the window. The Export window will open.

Step 2: Choose a format
1. At the top of the Export window, choose how you want to watch the slideshow:
•  Save as Video – for watching as a standard video file.
•  Save Only Audio – only the audio track of the slideshow will be saved, without video.
•  For Apple Devices – this allows you to save the slideshow in a format that's compatible with Apple devices.
•  For Android Devices – this allows you to save the slideshow in a format that's compatible with specific Android devices.
•  For Other Devices – here you can save the slideshow for watching on TVs, media players, and feature phones.
•  For Uploading Online – choose this tab if you want to share your video on YouTube, Facebook, Vimeo, or your blog.
Click on the relevant tab to see its options.

2. At the top of the tab you've selected, open the drop-down box and select the format or preset that you want to save the output
slideshow with.



 

 

Step 3: Check the export options
•  Project Settings shows the resolution and aspect ratio of the project. You can change the project settings before exporting by
clicking the pencil button.
•  Export Settings shows the output resolution and aspect ratio for the selected format or preset.
•  Estimated File Size shows approximately how much disk space the finished slideshow will occupy. If the size is too large, you
can try setting a smaller resolution in Project Settings or using a different output format.
 
At the bottom of the window, choose the folder where you want to save your slideshow and name the output file.

Step 4: Save the slideshow!
Finally, click the Start button in the Export window to begin processing the slideshow. For large slideshows, this may take
several minutes.



 

 

Saving your project for later
If you want to continue working on the slideshow later, you can save it as a project file that contains all your changes and
settings. Using this project, you can later modify the slideshow or save it to a different format. To save the project:
1. Open the File menu.
2. Choose Save Project.
3. A Windows Explorer dialog box will appear. Choose a location and name for the project file and click Save.
Don't forget to save your work once in a while.



 

 

Image size and quality
Even though image files rarely take up more disk space than videos or other media files, a large photo collection can quickly fill
up your hard drive if you save all photos at the maximum size and quality. In this section, you will learn how to manage image
file size.
 
Image file size is defined by the following properties:
 
•  Image size in pixels: the larger the image, the more pixels it will be made up of, and the more data will need to be stored. The
number of pixels also defines image resolution for printing, and affects the maximum level of detail you can achieve for a print of
a certain size.
 
To reduce file size, you can resize the image. However, this comes at a cost: the smaller copy will look just as good, but if you
want to print out the image or use it as wallpaper, the smaller file will look considerably worse than its original.
 
Let's see how much disk space you can save by resizing images. Below are the file sizes for one image (here, you see a scaled-
down preview), and the difference is amazing, resizing a large image to a viewable 800x600 size makes the file size over a
hundred times smaller.
 

Dimensions File Size

7899x5924 px 27,6 MB

800x600 px 168 KB

 
If you want to upload previews of your images to the web, or share photos in web albums, resizing the photos will most likely
be a good idea: the upload times will be faster, and if you have a storage limit, it won't be filled up as fast as if you uploaded the
images at their original size.
 
Batch resizing
 

Hint:
Don't scale up small, low-quality images.

An image with small dimensions does not have enough data in the file to allow any program to fully restructure the
quality of a larger size image. If you size them up, you will only be wasting disk space without any improvement in quality.

 
•  Image complexity: image complexity plays a large role in file size. Due to image compression specifics, images with different
content but identical size and format will differ in file size because of the details that will need to be preserved. For example, if
you save a large image of a purely blue background, some compression methods will only need to store which color fills the
whole image, while for a picture of a flower, all the small details will be stored to avoid quality loss.
 
Note the images below. They are of identical dimensions and are both saved in JPEG format. One image is a photo of a
complex and colorful flower, while the other is a plain blue background. The second image's file size, having to encode less
data, is 48 times smaller than the first! And while you can't simplify your photos to a single color, keep in mind that some images
will naturally have larger file size than others.
 

425x282 pixels



 

 

144 KB 2,98 KB
 
•  Format and compression method: A compression method can be seen as a shorthand writing system for image editing
software, where it can write all the data of your image into less space, and then decipher the shorthand to recreate the image on
your screen when you open the file. Most image compression methods do not store all of the image's data pixel by pixel, since
it would take significantly more disk space. Instead, the image compression algorythm finds a way to pack this information by
finding identical parts and only recording those same parts once, or by throwing away some data that it finds less important.
Different formats have different compression methods, and choosing the best format largely depends on the type and purpose of
the images.
 

Lossless formats: some formats can store the image without losing any data, meaning that the quality of the image will
not decrease when you save it. These formats can store the image either at its full size, or use a lossless compression
method, that will pack the image into a smaller file, yet retain the original quality. No matter the compression level, these
files are rather large, but offer the benefit of higher quality and sharper images, which is especially important for text
images and logos.
Common lossless formats: PNG, TIFF, BMP
 
'Lossy' formats: other formats allow you to save the images into smaller files, but they compress images at the expense
of some quality. For large photos, the trade-off is usually justified, as the human eye will probably not notice the
difference at low compression levels. However, when manually adjusting quality of 'lossy' formats, such as JPEG, it is
important not to set the quality too low to enjoy the image.
The most common 'lossy' format: JPEG

 
When you change an image's format, note that saving it to a lossless format will not improve its quality, but only
preserve the existing data. Likewise, if you change an image from a lossless format to a 'lossy' one, some data will
inevitably be lost to compression.

 
Saving files in a different format
Batch convert images
 
 
 



 

 

Settings

Click the cogwheel button in the upper right-hand corner of Movavi Photo Studio Launcher to open the settings. These settings
will apply to all of Movavi Photo Studio modules.
 

Interface language
Select your preferred language and click OK. The modules will also launch in the selected language.

Check for updates on startup
Movavi Photo Studio will search for newer versions of installed modules. Installing the updates is quick and
easy: just click the update button and Movavi Photo Studio will automatically download and install the update for

you.

Send anonymous usage stats to Movavi
Select this option if you want to participate in the Movavi Improvement Program. We collect basic information
about the program, such as which features you use most or any errors you may have encountered. We do not

collect any personally identifiable data, and only use the statistics to improve Movavi Photo Studio.
Movavi Improvement Program

http://www.movavi.com/mip.html


 

 

Help and support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.
 
Write to us at suppport@movavi.com...
or click the Live Chat button on the right to ask a support specialist via live chat.
 
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our
support team specialists may ask you for additional information that is required to solve your problem: these may include your
license key, log files, and files you were working with, but never personal information. We value your privacy!
 

Have you checked the FAQ section?
Your question may have already been answered!

 
Frequently asked questions:
How to activate Movavi Photo Studio?
How to buy the software?
How to update the graphics card drivers?

mailto:support@movavi.com
http://www.movavi.com/support/


 

 

System requirements

Both the Movavi Photo Studio launcher and all included applications require a stable Internet connection and administrator
permissions for downloading and installing.
 

Minimum system requirements Recommended configuration
Movavi Photo Editor

Operating system Windows XP/Vista/7/8 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1

GHz
2.2 GHz

Display resolution 1024x768, 32-bit color
 

1280x1024 or higher

RAM Windows XP, Vista – 512 MB
Windows 7, 8 – 1 GB

Windows XP, Vista – 2 GB
Windows 7, 8 – 4 GB

Available disk space 150 MB
Movavi Photo Batch

Operating system Windows XP/Vista/7/8 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1

GHz
2.2 GHz

Display resolution 1024x768, 32-bit color 1280x1024 or higher
RAM Windows XP, Vista – 512 MB

Windows 7, 8 – 1 GB
Windows XP, Vista – 2 GB
Windows 7, 8 – 4 GB

Available disk space 150 MB
Movavi Slideshow Creator

Operating system Windows XP/Vista/7/8 with latest service packs and patches
Processor Dual-core Intel, AMD or compatible

processor, 1 GHz
Quad-core processor, 2.2 GHz and above

Graphics NVIDIA® GeForce™ series 6 or higher
AMD Radeon™ R600 or higher graphics card with up-to-date drivers

Resolution 1024x768, 32-bit color 1280x1024 or higher

RAM Windows XP, Vista – 512 MB
Windows 7, 8 – 1 GB

Windows XP, Vista – 1 GB
Windows 7, 8 – 2 GB

Available disk space 400 MB for installation
500 MB for ongoing operations

2 GB

Additional features  Sound card for audio playback
  Latest version of QuickTime Player for

Windows for MOV processing



 

 

Supported formats
 

Movavi Photo Editor
 
 

 
Format

 
Input

 
Output

BMP

DPX

EXR  

GIF*  

JPEG

JPEG 2000  

JPEG-LS  

PAM  

PBM

PCX

PGM

PNG

PPM

SGI  

Sun Rasterfile  

TARGA

TIFF

WebP  

XBM

XFace  

XWD  
* Only non-animated GIFs
 

Movavi Photo Batch
 
 

 
Format

 
Input

 
Output**

 
Convert to

BMP

DPX  

EXR   

GIF*   

JPEG

JPEG 2000   

JPEG-LS   

PAM   

PBM  



 

 

PCX  

PGM  

PNG

PPM  

SGI   

Sun Rasterfile   

TARGA  

TIFF

WebP   

XBM  

XFace   

XWD   
* Only non-animated GIFs
** If the original format is not supported as an output format, the files will be saved as JPEG.
 
 

Slideshow Creator
 

 
 

Video Formats
 

Supported Codecs

Read / Write H.263
3GPP (.3gp), 3GPP2 (.3g2)

Read Only H.264, MPEG-4
Advanced Streaming Format (.asf) Read Only MPEG-4, VC-1, WMV V7

Read / Write H.264, MPEG-4
Audio Video Interleave (.avi) Read Only H.263, MJPEG, DivX, Xvid, DV, Cinepack,

Fraps, TechSmith, Uncompressed
DivX Video (.divx) Read Only DivX

Read / Write H.264
Flash (.flv)

Read Only FLV1, H.263, Flash Screen Video
Read / Write FLV1

Flash (.swf) Read Only MJPEG

HD-видео
(.m2ts, .mkv, .mov, .mp4, .mpg, .wmv)

Read / Write MPEG-2, MPEG-4, H.264, WMV V8

HD-видео (.m2t, .mts, .ts, .wmv) Read Only MPEG-2, MPEG-4, H.264, AVCHD,WMV
9, WMV 9 Advanced profile

Read / Write H.264
Matroska (.mkv) Read Only MPEG-4, MJPEG, Theora, DV,

Uncompressed
MPEG Transport Stream (.m2ts) Read / Write H.264

MPEG Transport Stream (.ts, .mts, .m2t) Read Only MPEG-2, H.264

MPEG (.mpg) Read / Write MPEG-1, MPEG-2

MPEG (.mpeg, .mpe, .m1v, .mod, .tod) Read Only MPEG-1, MPEG-2, H.264
Read / Write MPEG-4, H.264

MPEG-4 (.mp4) Read Only H.263, MJPEG, ProRes



 

 

MPEG-4 (.m4v) Read Only MPEG-4, H.264, H.263, MJPEG, ProRes
MXF – Material eXchange Format (.mxf) Read Only MPEG-2, DV

Read / Write Theora
OGV – Ogg Video (.ogv)

Read Only MPEG-4
Read / Write H.264

QuickTime (.mov) Read Only MPEG-4, AIC, MJPEG, ProRes, Sorenson
1/3, PNG

QuickTime (.qt) Read Only H.264, MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3

RM – RealMedia (.rm, .rmvb) Read Only Real Video 2/3/4, Cooker
Read / Write VP8

WebM (.webm)
Read Only VP7, VP9

Read / Write WMV V8

WMV – Windows Media Video (.wmv) Read Only WMV V7, WMV 9, WMV 9 Screen,WMV
9 Advanced profile, MPEG-4,WMV 9.1
Image V2

WTV – Windows Recorded TV Show
(.wtv)

Read Only H.264, MPEG-2

 
Audio Formats

 
Supported Codecs

AAC – Advanced Audio Coding (.aac) Read / Write AAC
AMR – Adaptive Multi-Rate audio codec
(.amr, .3ga)

Read Only AMR

AIFF – Audio Interchange File Format
(.aif,.aiff)

Read Only Uncompressed

APE – Monkey's Audio (.ape) Read Only Monkey's Audio
Au (.au, .snd) Read Only PCM
FLAC – Free Lossless Audio Codec (.flac) Read / Write FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) Read / Write MP3

MPEG-4 (.m4a, .m4b) Read / Write AAC
MPEG-4 (.m4a, .m4b) Read Only AAC, PCM, ALAC
OGG – Ogg Audio (.ogg) Read / Write Vorbis

Read / Write PCMWAV – Waveform Audio File Format
(.wav)

Read Only AAC, MP3
Read / Write WMA 9WMA – Windows Media Audio (.wma)

Read Only WMA Pro, WMA Voice
 

Image Formats
 

Supported Codecs
BMP (.bmp) Read Only BMP
DPX (.dpx) Read Only DPX
GIF (.gif) Read Only GIF

JPEG (.jpg. jpg, .jp2, .jls) Read Only MJPEG, JPEG2000, JPEGLS
Netpbm formats (.pgm, .pbm, .ppm, .pam) Read Only PGM, PBM, PPM, PAM, PGMYUV

PCX (.pcx) Read Only PCX
PNG (.png) Read Only PNG
PTX (.ptx) Read Only PTX
SGI (.sgi) Read Only SGI



 

 

TARGA (.tga) Read Only TARGA
XBM (.xbm) Read Only XBM
XWD (.xwd) Read Only XWD
 
 



 

 

Updating graphics card drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your
graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that
notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-
date will ensure stable performance of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the
Adapter Type section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver
downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some
manufacturers may also offer a utility that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your
system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the
computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver
updates and allows you to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the
application, please try the method above.
NVIDIA download center
 
2. In the Drivers section, click the Check for updates button to find the latest drivers.
 
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically
download and install the necessary driver for your system.

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
http://www.nvidia.com/Download/index.aspx?lang=en-us


 

 

Updating AMD® or ATI® Driver
 
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver
Downloads page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages
you have encountered. This will help our support team specialists solve your problem quicker.
 
 

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
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